
Frequently Asked Questions 

  +Device does not appear in G HUB 

If some features of G HUB do not appear to work correctly and restarting doesn't help, try this: 

1. Go to Device Manager (WIN+PAUSE|BREAK). 

2. Click on View at the top and view Devices by container. 

3. Look for your device and expand it. You are looking for the name of the device, for 

example, Logitech Pro X Gaming Headset, or Logitech G560 Gaming Speaker. 

4. Right-click and select Uninstall Device.  

 

5. Check Delete the driver software for this device and then click Uninstall.  



 

6. Unplug the device and plug it back into a different USB port. 

It should re-enumerate and be detected in G HUB. 

7. G HUB should then download the driver for your device. 

If issues persist: 

Run G HUB with the default settings: 

1. Exit G HUB by right-clicking the applet in the task tray and selecting Quit. 

2. Navigate to C:\Users\[USERNAME]\AppData\Local\LGHUB, where [USERNAME] 

will specific to your account. 

3. Find settings.json and make a copy and back this up somewhere on your computer. The 

Desktop is a good place so you can find it easily. 

4. Navigate to C:\Users\[USERNAME]\AppData\Local\LGHUB, where [USERNAME] 

will be specific to your account. 

5. Delete the settings.json file in the LGHUB folder. 

6. Run G HUB. You will notice that all the settings have been set back to default and the 

settings.json file has been rebuilt. 

Restoring your old settings 
If you want to restore your old settings: 

1. Quit G HUB. 

2. Copy and paste the backup of settings.json that you saved earlier into the 

C:\Users\[USERNAME]\AppData\Local\LGHUB folder. 

3. Run G HUB — your old settings should be restored. 

  +G HUB freezes while loading and logo animation loops 

If G HUB seems to be stuck while trying to load and the logo animation loops, try the following: 

1. Exit G HUB by right-clicking the applet in the task tray and selecting Quit.  



 

2. Navigate to Task Manager (CTRL+ALT+DEL). 

NOTE: You may also need to click More Details at the bottom of the window 

Look for LGHUB, LGHUB Agent and LGHUB Updater, right-click and choose End 

task on each.  

 

3. Once those processes are ended, navigate to C:\Program Files\LGHUB and run these in 

order:  

o Lghub_updater.exe 

o Lghub_agent.exe 

o Lghub.exe 

This should resolve the logo spinning issue. If it doesn’t, then make sure you’re running with 

admin privileges. G HUB might need to update and needs admin privileges to do this. 

If you’re using an administrator account and the issue persists, please follow the steps in G HUB 

Install/Uninstall/Update Troubleshooting. 

  

  +Audio device not recognized 

https://support.logi.com/hc/en-us/articles/360023192454-G-HUB-Install-Uninstall-Update-Troubleshooting
https://support.logi.com/hc/en-us/articles/360023192454-G-HUB-Install-Uninstall-Update-Troubleshooting


If you have problems with a headset or speaker, the following: 

Revert back to Microsoft drivers: 

1. Go to Device Manager (WIN+PAUSE|BREAK). 

2. Click on the View tab at the top and select Devices by container. 

3. Look for your headset/speaker and expand it. You are looking for the named device, for 

example, Logitech G560 Gaming Speaker or Logitech Pro X Gaming Headset.  

 

4. Right-click and click Properties and then select the Driver tab. 

The Driver Provider should be Logitech — if it’s Microsoft you don't need to change 

the driver. 

5. If the driver is Logitech, click Update Driver and then Browse my computer for driver 

software > Let me pick from a list... > and choose USB Audio Device.  



 

6. Click Next. This should update back to Microsoft's standard drivers. 

Update to latest Logitech Audio Driver: 

1. On the same device in Device Manager, right-click on Properties and then click the 

Driver tab. 

2. Click Update Driver > Browse my computer for driver software. 

3. Click the Browse button to the right of Search for drivers in this location: 

Navigate to: C:\ProgramData\LGHUB\depots\2xxxx\driver_audio\ (note that although 

the five-digit number might be different, you are looking for a folder containing the 

driver audio folder).  



 

4. Click Next to update to the latest audio driver. 

If issues persist: 

1. Go to Device Manager (WIN+PAUSE|BREAK). 

2. Click on View at the top and select View devices by container. 

3. Look for your device in the list and expand it. You are looking for the named device, for 

example, Logitech Pro X Gaming Headset, or Logitech G560 Gaming Speaker. 

4. Right-click and select Uninstall device.  



 

5. Check Delete the driver software for this device and then click Uninstall.  

 

6.  Unplug the device and plug it back into a different USB port. It should re-enumerate and 

be detected in G HUB. 

7. G HUB should then download the driver for your device. 

  +Performance and endurance power modes on the G304 and G305 gaming mice 



You can use Logitech Gaming Software (LGS) to switch between power modes on your gaming 

mouse to optimize battery performance:  

 Endurance mode (LO): The report rate of the mouse is fixed at 8 ms (125 Hz) to 

maximize battery life. The report rate in endurance mode cannot be adjusted. 

 Performance mode (HI): By default, the mouse report rate is set to 1 ms (1000 Hz). But 

you can increase the report rate in performance mode to 2 ms (500 Hz), 4 ms (250 Hz) or 

8 ms (125 Hz). 

LGS has a blue (performance) or green (endurance) colored circle at the top-left next to the 

battery level to help you distinguish the active power mode:  

 

 Select a power mode in Automatic Game Detection mode 

 Select a power mode in On-Board Memory mode 

NOTE: To learn more about On-Board Memory and Automatic Game Detection Modes, 

see Choose between gaming mouse On-Board Memory and Automatic Game Detection modes.  

 

Select a power mode in Automatic Game Detection mode 
LGS can be used to select a power mode for all profiles or on a per-profile basis.  

1. Launch LGS. 

2. Select the G304/G305 from the product picker. 

3. Click the Customize Buttons icon at bottom of the screen.  

https://support.logi.com/hc/en-us/articles/360025330873--FAQ-G305-LIGHTSPEED-Wireless-Gaming-Mouse#ags
https://support.logi.com/hc/en-us/articles/360025330873--FAQ-G305-LIGHTSPEED-Wireless-Gaming-Mouse#onboard
https://support.logi.com/hc/en-us/articles/360023177194


 

4. Make sure to select the profile you want to customize in the Profiles pane. Click on the 

drop-down list next to Power Mode and select HI for performance mode, and LO for 

endurance mode.  

 



NOTE: You can also use a single profile on your mouse in Automatic Game Detection 

mode. Just clear the Enable per profile settings checkbox. Remember that you cannot 

have per profile DPI sensitivity levels while the setting is disabled (not checked). If you 

use multiple profiles, we recommend performance mode for gaming and endurance mode 

for all other profiles/applications. 

 

Select a power mode in On-Board Memory  

1. Launch LGS. 

2. Select the mouse from the product picker. 

3. Click the Customize on-board profile icon at bottom of the screen.  

 

4. Click on the drop-down list next to Power Mode in the Advanced section, and select HI 

for performance mode, and LO for endurance mode.  



 

  +Connect the G304 or G305 gaming mouse to a computer 

You can connect the G304 or G305 gaming mouse to your computer with the included 

LIGHTSPEED USB receiver. Before you connect your mouse to the computer, make sure 

you’ve installed one AA battery.   

1. Push downwards on the grooves to slide off the keyplate, leaving the battery cage 

exposed.  

 



2. Take the LIGHTSPEED receiver out of the battery cage so you can connect it to your 

computer.  

 

3. Install the AA battery in the battery cage as illustrated below.  

 

4. Slide the keyplate upwards to return it to its original position, covering the battery cage.  



 

5. Connect the receiver extension cable to a USB port on your computer. Connect the 

LIGHTSPEED receiver to the other end of the extension cable.  

 

 

NOTE: You can also connect the LIGHTSPEED receiver directly to a USB port on your 

computer.  

TIPS:  

o Keep the mouse and receiver at least 2 m from wireless routers or other 2.4GHz 

wireless devices to minimize environmental noise. 

o To ensure optimal performance in noisy wireless environments, we recommend 

that you keep the receiver within 20 cm of the mouse.  



 

6. Turn the mouse around so the scroll wheel faces the surface, and use your thumb or a 

finger to push the power switch right. 

7. The mouse and LIGHTSPEED receiver connect automatically. For more information 

about the LED indicator, see LED Indicator on the G304 and G305 gaming mouse. 

  

  +Finding the correct .exe file for a gaming-mouse profile 

If you're having trouble with profile detection, you may not have the profile associated with the 

correct or active game .exe file. 

To find the active .exe for a game, you can either: 

 Associate automatically using a G-Series keyboard with an LCD screen (see 

360023243694). 

OR 

 Find the .exe through Windows Task Manager (see 360023243694). 

NOTE: You only need to do one of the above if the profile is not associated correctly. If you can 

point to the correct .exe when creating a profile, you don't need to do either one. 

  +Troubleshooting gaming mouse profile detection using Logitech Gaming Software 

https://support.logi.com/hc/en-us/articles/360023362213
https://support.logi.com/hc/en-us/articles/360023190294
https://support.logi.com/hc/en-us/articles/360023356993


You can configure your gaming mouse separately for each game or application on your computer 

(see 360023406553 for instructions). When a game is launched, the profile associated with it 

should activate. Sometimes, the profile doesn't activate properly, which can prevent game-

specific settings from being applied. 

When a game profile isn't activating properly: 

 Try using a Persistent Profile (see answer 360023406553 for instructions).  

NOTE: Using a persistent profile will help you determine if the Logitech Gaming 

Software is working properly. 

 Make sure the correct .exe file is selected for the game (see answer 360023406553 for 

help). 

 Check that both the single player and multiplayer .exe files have profiles (see 

answer 360023406553 for help). 

  +Troubleshooting mouse button assignments and macros using Logitech Gaming 

Software 

When your button assignments and macros aren't working the way you configured them, the 

problem usually has to do with the active profile. 

Here are some ways to try and resolve this issue: 

 Lock the profile while the game is running (see answer 360023406013 for instructions). 

 Try using a Persistent Profile to determine if the software is working properly (see 

answer 360023406013 for instructions). 

 Check that the correct .exe is selected for the game (see answer 360023406013 for help). 

 Make sure both the single player and multiplayer .exes have profiles (see 

answer 360023406013 for help). 

  +Linking profiles between a G-Series keyboard and gaming mouse using Logitech 

Gaming Software 

Logitech Gaming Software (LGS) shares the profiles between your G-Series keyboard and your 

gaming mouse, so no manual profile linking is needed. Macros and keystrokes you configured 

for your G-Series keyboard can be assigned to your gaming mouse, and mouse button presses 

you configured for your gaming mouse can be assigned to your G-Series keyboard. 

NOTE: Certain mouse-specific buttons, like DPI Shift, can only be used with LGS-compatible 

mice. If you assign a G-Key on your keyboard as DPI Shift with a non-LGS mouse, the button 

will have no effect. Most other button presses, like Left and Right Click, can be assigned to your 

G-Keys. 

  +Gaming mouse profile stops working in the middle of a game 

https://support.logi.com/hc/en-us/articles/360023356953
https://support.logi.com/hc/en-us/articles/360023190074
https://support.logi.com/hc/en-us/articles/360023243694
https://support.logi.com/hc/en-us/articles/360023358073
https://support.logi.com/hc/en-us/articles/360023190494
https://support.logi.com/hc/en-us/articles/360023190074
https://support.logi.com/hc/en-us/articles/360023243694
https://support.logi.com/hc/en-us/articles/360023358073


When a profile stops working in the middle of a game, there are two possible causes. Either the 

profile is: 

 Not associated with the correct .exe file 
The profile is detected in the game launcher or menu, but stops working while playing the 

game. This happens when the profile isn't associated to the correct .exe file. You can fix 

this by assigning the game's .exe file to the profile and not the launcher's .exe file. See 

360023405833 for instructions. 

OR 

 Reverted to the Default Profile 
Another application running on your computer may come to the foreground, causing the 

active profile to revert to the Default Profile. You can fix this by locking the profile 

assigned to the game. See 360023405833 for instructions. 

  +Cursor does not follow gaming mouse movements 

If the cursor isn't following the movements of your mouse, try the following: 

 Make sure your mouse is firmly connected to a USB port on your computer (not to a 

USB hub). 

 Try a different mouse pad. 

 Check the sensor port (on the bottom of the mouse) for dust or lint. 

 Avoid using your mouse on: 

  

o Glass or other see-through surfaces 

o Reflective surfaces, such as mirrors and metal desks 

o Wood grains and grooved surfaces 

o Very high gloss finished surfaces 

 Try the mouse on a piece of white paper to make sure it isn't a tracking issue on a 

particular surface you're using. 

If the above steps don't resolve your problem, the erratic movement may be caused by software 

(for example, if the cursor speed is set too fast). 

  +My gaming-mouse profile stopped working after a game update 

Each profile is associated with a specific .exe file. Sometimes, when you install a game update or 

expansion pack, the location of the correct.exe may change. 

If you recently installed a game update and then your game profile stopped working, see 

answer 360023405693 for help with finding the current game .exe. 

  +Gaming mouse and keyboard compatibility with USB hubs and KVM switches 

https://support.logi.com/hc/en-us/articles/360023243694
https://support.logi.com/hc/en-us/articles/360023190494
https://support.logi.com/hc/en-us/articles/360023243694


We don't support the use of third-party devices with our mice and keyboards. They can interfere 

with communication between a mouse or keyboard and the computer. 

Unsupported third-party devices include: 

 KVM switch boxes 

 Port replicators 

 Docking stations 

 USB hubs 

NOTE: The manufacturers of these third-party devices implement keyboard and mouse support 

in different ways. There is currently no industry standard. 

  +Purchase a new gaming mouse receiver 

If you’ve lost or misplaced the receiver for your gaming mouse:  

1. Go to support.logitech.com.  

2. Search for your gaming mouse or use the drop-down menus to locate the product's 

support page.   

 

3. If there is a spare receiver for your gaming mouse, it’ll be listed under “Spare Parts”. 

Select the part and then click Add to cart.  

http://support.logitech.com/


 

 

If there isn’t a spare receiver listed for your gaming mouse, please contact Logitech Support. 

  

  +Gaming mouse compatibility with Logitech Unifying receivers 

The Logitech G403 Wireless, G304, G305, G603, G703, G903 are built on the LIGHTSPEED 

architecture and connect to proprietary LIGHTSPEED receivers. They are not compatible and 

cannot be paired with the Unifying receiver. 

  

  +Pair Logitech G gaming mouse to a LIGHTSPEED receiver 

If your gaming mouse becomes unpaired or if you receive a replacement LIGHTSPEED 

receiver, follow these instructions to pair your mouse with the receiver:  

1. Connect the LIGHTSPEED receiver to a USB port on the computer. 

2. Download the Logitech Connection Utility from the Downloads page. 

3. Launch the Logitech Connection Utility. 

4. Press Next to start the pairing process.  

https://support.logi.com/hc/requests/new?ticket_form_id=360000621393
https://support.logi.com/hc/articles/360025141574


 

5. Turn the mouse OFF and then ON using the power switch on the bottom of the mouse.  

 

6. Your gaming mouse should now be paired with the receiver. Click Yes and then Next.  



 

7. Click Finish to exit the Logitech Connection Utility.  

 

 

  

  +Gaming mouse double-clicks when clicked once 



If your gaming mouse clicks two or more times when clicked once, try the troubleshooting steps 

below:  

1. Disable the single-click to open option in Windows:  

o Windows 8 or Windows 10  

 Click on the magnifying glass to bring up the Search menu, type ‘single-

click’, and then select Specify single- or double-click to open. 

 Select the General tab, and under Click items as follows, make sure 

Double-click to open an item (single-click to select) is selected.  

 

2. Windows 7 or Windows Vista:  

o Click on Computer.  

 

o On the menu bar, click Organize then Folder and Search Options.  



 

o Under the General tab, make sure that the option Double-click to open an item 

(single-click to select) is selected.  

 

o Click OK to save and exit. 

3. Test the mouse in multiple programs and components such as Control Panel or Windows 

Explorer on Windows, and Disk Utility or Finder on Mac OS. If the double-click is 

specific to one program, check the application settings or command assignments for the 

specific profile in Logitech Gaming Software.  

4. Bypass any power hubs or extenders and connect your mouse cable or receiver to a 

different USB port on the computer’s motherboard, if possible. 

5. Test the mouse on a different computer that is functional.  

6. Contact Logitech Support if the double-click issue appears on a different computer. Let 

us know what troubleshooting steps have been attempted. 

 

 

  

  +Customize G304 or G305 pointer settings using Logitech Gaming Software 

https://support.logi.com/hc/requests/new?ticket_form_id=360000621393


You can use Logitech Gaming Software (LGS) 9.00 or later to customize pointer settings on the 

G304 or G305 gaming mouse in two different modes:  

 Automatic Game Detection 

 On-Board Memory 

NOTE: For help choosing between the two modes, see Choose between gaming mouse On-

Board Memory and Automatic Game Detection modes. 

 

Automatic Game Detection  

1. Open LGS 

2. In the Home window, make sure the blue toggle marker is set to Automatic Game 

Detection, and then click the glowing pointer-gear icon.  

 

The Customize Pointer Settings window appears:  

https://support.logi.com/hc/en-us/articles/360025330873--FAQ-G305-LIGHTSPEED-Wireless-Gaming-Mouse#automatic
https://support.logi.com/hc/en-us/articles/360025330873--FAQ-G305-LIGHTSPEED-Wireless-Gaming-Mouse#onboard
https://support.logi.com/hc/en-us/articles/360023177194
https://support.logi.com/hc/en-us/articles/360023177194


 

Your gaming mouse supports the following pointer customizations in Automatic Game 

Detection mode:  

o DPI levels — Configure up to five levels, from 200-12000 in 50 DPI increments. 

o Report rate (performance mode only) — Update from 125/sec (8ms response 

time) to 1000/sec (1ms response time). 

o Per profile pointer settings — Enable different pointer behavior for each game 

profile. 

o Acceleration — Enhance pointer precision – the mouse pointer increases speed 

when you move it. For some games, this can be turned off to improve accuracy. 

o Power Mode — Choose between two power modes to optimize battery life for 

your needs. 

To configure your pointer settings:  

1. Under DPI Sensitivity Levels, drag the tick marks along the graph. For each DPI level, 

you'll see a tick mark with a unique color. The LED on top of the mouse shows the 

unique color of the active level while using DPI Cycling command. You can set up to 

five sensitivity levels.  

NOTE: If you prefer, you can edit the list of DPI values to the left of the graph from 200-

12000. For each DPI level you set, you'll see a tick mark rounded to the nearest 50. 

For example: If you type in "682", the software will round to 700 DPI.   

o Assign Default — One DPI level must always be the default. To change the 

default, click a DPI level that doesn't have a blue diamond above it, and then click 

Assign Default. This is the DPI level the mouse will return to when you:   



 Press the default DPI button  

 Switch between profiles  

 Power up the computer  

 Wake the computer from sleep mode 

o Assign Shift — You can quickly activate a DPI level when you press the DPI 

Shift button. For example, you can set  Assign Shift to a low DPI value, which 

will temporarily give you extreme precision. When you release the button, the 

mouse will revert back to the current DPI level. To set the Shift DPI, select a DPI 

level that isn't highlighted in orange, and then click Assign Shift.   

TIP: Buttons you assign as DPI Up, DPI Down, DPI Shift and DPI Cycling will enable 

you to change between DPI levels rapidly. 

2. In Performance Mode, change the Report Rate, if you prefer something other than the 

default of 1000 reports/second (1ms response time). The Report Rate controls how often 

your mouse updates its position to the computer.  

NOTE: The report rate setting cannot be changed while the gaming mouse is in 

endurance mode. Switch to performance mode if you want to increase the report rate. 

The possible range is from 125/sec (8ms response time) to 1000/sec (1ms response time). 

You can:   

o Decrease processor use by reducing the report rate.  

o Increase the mouse response by raising the report rate.  

o Extend battery life by reducing the report rate. 

3. Make your preferred selections under Advanced. The options are:   

o Enable per profile pointer settings — Select this option to enable each profile in 

LGS to have different pointer behavior (see Setting different DPIs for gaming-

mouse profiles using Logitech Gaming Software for help).  

o Acceleration (Enhance Pointer Precision) — Select this option to use Window's 

"Enhance Pointer Precision" acceleration.  

TIP: For gaming accuracy, we recommend leaving this unchecked, but you can 

enable it if you prefer the feel of default Windows acceleration. 

o Power mode —  Click on the drop-down menu and select between HI for 

performance mode and LO for endurance mode. Report rate is fixed at 8ms while 

endurance mode is active to conserve battery life. In performance mode, the 

possible range is from 125 reports/sec (8ms response time) to 1000 reports/sec 

(1ms response time). For more information, see Performance and Endurance 

power modes on the G304 and G305 gaming mice. 

On-Board Memory 
In On-Board Memory mode, all of the customizations you make will be written directly to the 

mouse.  

 

Your gaming mouse supports these pointer customizations in On-Board Memory mode:  

 DPI levels — Configure up to five levels, from 200-12000 in 50 DPI increments. 

https://support.logi.com/hc/en-us/articles/360023425293
https://support.logi.com/hc/en-us/articles/360023425293


 Report rate (Performance mode only) — Update from 125/sec (8ms response time) to 

1000/sec (1ms response time). 

 Power Mode — Choose between two power modes to optimize battery life for your 

needs. 

To customize pointer settings:  

1. Open LGS 

2. In the Home window, make sure the blue toggle marker is set to On-Board Memory, 

and then click the glowing pointer-gear icon.   

 

The Customize On-Board Pointer Settings window appears:  



 

3. Under DPI Sensitivity Levels, drag the tick marks along the graph. For each DPI level, 

you'll see a tick mark with a unique color. The LED on top of the mouse shows the 

unique color of the active level while using the DPI Cycling mouse function. You can set 

up to five sensitivity levels:   

o Assign Default — One DPI level must always be the default. To change the 

default, click a DPI level that doesn't have a blue diamond above it, and then click 

Assign Default. This is the DPI level the mouse will return to when you:   

 Press the default DPI button  

 Switch between profiles  

 Power up the computer  

 Wake the computer from sleep mode 

o Assign Shift — You can quickly activate a DPI level when you press the DPI 

Shift button. For example, you can set  Assign Shift to a low DPI value, which 

will temporarily give you extreme precision. When you release the button, the 

mouse will revert back to the current DPI level. To set the Shift DPI, select a DPI 

level that isn't highlighted in orange, and then click Assign Shift.   

TIP: Buttons you assign as DPI Up, DPI Down, DPI Shift and DPI Cycling will 

enable you to change between DPI levels rapidly. 

4. In Performance Mode, change the Report Rate, if you prefer something other than the 

default of 1000 reports/second (1ms response time). The Report Rate controls how often 

your mouse updates its position to the computer.  

NOTE: The report rate setting cannot be adjusted while the gaming mouse is in 

endurance mode. Switch to performance mode if you want to change the report rate. 

The possible range is from 125/sec (8ms response time) to 1000/sec (1ms response time). 

You can:   



o Decrease processor use by reducing the report rate  

o Increase the mouse response by raising the report rate  

o Extend battery life by reducing the report rate 

5. Click on the drop-down menu next to Power mode and select between HI for 

performance mode and LO for endurance mode. Report rate is fixed at 8ms while 

endurance mode is active to conserve battery life. In performance mode, the possible 

range is from 125 reports/sec (8ms response time) to 1000 reports/sec (1ms response 

time). For more information, see Performance and Endurance power modes on the G304 

and G305 gaming mice. 

  +LED Indicator on the G304 and G305 gaming mice 

There is one LED indicator on top of your gaming mouse. 

   

LED 

Color 
Status Duration 

Green 

The mouse is switched from performance to 

endurance mode in Logitech Gaming 

Software (LGS) or turned on while in 

endurance mode. 

5 seconds 

Cyan 

Mouse is switched from endurance to 

performance mode in Logitech Gaming 

Software (LGS) turned on while in 

performance mode. 

5 seconds 

Red Battery level below 15% 

Blinks for 30 

seconds after the 

mouse is switched 

on. 

Yellow Sensitivity level 1 active 5 seconds 

White Sensitivity level 2 active 5 seconds 

Orange Sensitivity level 3 active 5 seconds 

Magenta Sensitivity level 4 active 5 seconds 

Blue Sensitivity level 5 active 5 seconds 

 

NOTE: The sensitivity level indicators are prioritized over the power on, mode switch, 

connection switch, and battery level indicators. 

 

For more information about Performance and Endurance modes, see Performance and Endurance 

modes on the G304 and G305 gaming mice. 

  

https://support.logi.com/hc/en-us/articles/360023425293
https://support.logi.com/hc/en-us/articles/360023425293
https://support.logi.com/hc/en-us/articles/360023425293
https://support.logi.com/hc/en-us/articles/360023425293


  +Inconsistent gaming mouse tracking behavior 

If the cursor for your gaming mouse stutters, or skips during general usage, try these 

troubleshooting steps:  

1. If you have Logitech Gaming Software (LGS) installed:  

o Lower your DPI sensitivity in the Customize Pointer Settings tab. 

o If your gaming mouse supports surface tuning, tune your mouse to the surface in 

use. See Surface Tuning your gaming mouse for more information. 

2. If you don't have LGS installed, lower your Pointer Speed in Control Panel > Mouse > 

Pointer Options:  

 

3. If your mouse is wireless:  

o Recharge the mouse using the included cable or replace the batteries. 

o Make sure the mouse and USB receiver are at least 2 meters away from wireless 

routers and other 2.4 GHz wireless devices.  

o Keep the USB receiver within 20 cm of the mouse. 

o Temporarily disconnect any other wireless devices and observe the effect on the 

tracking performance. 

4. The sensor lens may be dirty. Turn your mouse over and thoroughly clean any dirt or lint 

covering the lens. 

5. Try using the mouse on a piece of white paper to make sure it isn't a tracking issue on a 

particular surface you're using. 

https://support.logi.com/hc/en-us/articles/360023176274


If none of these suggestions work, please contact Logitech Support and let us know what 

troubleshooting steps you've tried. 

  

  +Inconsistent tracking behavior between gaming mouse performance and endurance 

modes 

If you notice inconsistent tracking behavior with the same sensitivity (DPI) levels between the 

performance and endurance modes on your gaming mouse, you need to disable the Enhance 

pointer precision mouse setting in Windows. Here’s how:  

1. Open the Control Panel. 

2. Click Mouse to open the Mouse Properties window. 

3. Click the Pointer Options tab. 

4. Uncheck Enhance pointer precision.  

 

5. Click OK to save your changes. 

  +Digital signature error when Logitech Gaming Software is installed on Windows 7 

computers 

https://support.logi.com/hc/requests/new?ticket_form_id=360000621393


You may see a digital signature error when you install Logitech Gaming Software (LGS) on 

some Windows 7 computers. All recent versions of LGS require the following Microsoft 

Windows security update to be installed prior to installing LGS:  

 Security Update for Windows 7 Systems (KB3033929) 

The security update adds support for SHA-2 driver signing and verification functionality. There 

are two versions — one for Windows 7 32-bit (x86) and one for Windows 7 64-bit (x64). Make 

sure you've downloaded and installed the correct version for your computer before you install 

LGS.  

  +Choose between gaming mouse On-Board Memory and Automatic Game Detection 

modes 

Your gaming mouse offers two different ways to manage pointer settings, button configuration, 

and lighting settings:  

 On-Board Memory — The pointer settings, button configuration and lighting settings 

are written to the memory of the mouse. This allows you to configure the mouse on one 

computer, and then use your mouse on a different computer with no additional software 

or configuration. This setting is also useful if you want to only use one set of button 

configurations for all applications/games on your computer. See Enable On-Board 

Memory mode on your gaming mouse with Logitech Gaming Software for details. 

 Automatic Game Detection — The pointer settings, button configuration and lighting 

settings are individually configured for every application and game on your computer. 

This setting is recommended for advanced users, and for when you want to assign 

specific commands for each application on your computer. See Enable Automatic Game 

Detection mode on your gaming mouse with Logitech Gaming Software for details. 

  +Enable On-Board Memory mode on your gaming mouse with Logitech Gaming 

Software 

You can use Logitech Gaming Software (LGS) to enable On-Board Memory mode for your 

gaming mouse. Here’s how:  

1. If your mouse is wireless, make sure it’s connected to your computer using the supplied 

USB cable or the wireless USB receiver. 

2. Open LGS, select your gaming mouse and navigate to the Home tab.   

https://support.logi.com/hc/en-us/articles/360023344753
https://support.logi.com/hc/en-us/articles/360023344753
https://support.logi.com/hc/en-us/articles/360023344693
https://support.logi.com/hc/en-us/articles/360023344693


 

3. Make sure the blue toggle marker is set to the left (shown below):  

 

4. Your mouse will now be in On-Board Memory mode and all of the customizations you 

make in LGS will be written directly to the mouse.  



  +Enable Automatic Game Detection mode on your gaming mouse with Logitech Gaming 

Software 

You can use Logitech Gaming Software (LGS) to enable Automatic Game Detection mode your 

gaming mouse. Here’s how:  

1. If your mouse is wireless, make sure that it’s connected to your computer using the 

supplied USB cable or the wireless USB receiver. 

2. Launch LGS, select your gaming mouse and navigate to the Home tab.  

 

3. Make sure the blue toggle marker is set to the right (shown below):  



 

4. The mouse will now be in Automatic Game Detection mode and all of the customizations 

you make in LGS will be active when the corresponding game or application is launched 

or running on your computer.  

 


